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Preface

This document chronicles my experience photographing the total solar eclipse of April 8, 2024
in Doaktown, New Brunswick. The likelihood of sunshine on April 8 in New Brunswick is
about 20%, and much less for an “eclipse sky”, i.e. cloudless and crystal clear to the horizon.
In fact, of all places along the line of totality from Mazatlan, Mexico to Newfoundland,
Atlantic Canada had by far the worst likelihood of clear skies but, living in Halifax, New
Brunswick was as far as we were willing to go and so we took our chances.

Despite these overwhelming odds and by what can only be described as an astonishing
stroke of luck, we were blessed with an absolutely perfect eclipse sky! Sadly, most other
places along the line of totality were clouded out, including Mazatlan with an 80% chance
of clear skies in April, and Niagara Falls where a state of emergency was called to manage
the anticipated crowds, and where hotel rooms for April 7 and 8 were inflated to more than
C$1,000 per night! Meanwhile, on the beautiful grounds of Doaktown’s Atlantic Salmon
Museum by the Miramichi River with blazing sunshine and not a cloud in the sky, the
crowds our party of six had to fight off included three other small groups sharing an acre or
more of museum grounds . . .

This was my third total eclipse (P.E.I., 1972; Novillero Mx., 1991; Doaktown, 2024),
and fourth if you include the annular eclipse over Halifax in 1994. Of the four, this was my
third attempt at photographing the event and by far my most successful. For posterity then
and in case anyone is interested, I describe my equipment and preparations, the photos I
took, and the post-processing I did with Photoshop to produce the images needed for the
compositions which I include at the end of this document. As a rank amateur myself, I hope
my descriptions are approachable enough to the reader who, perhaps for the first time, may
be considering recording the next occurrence of what has to be “the greatest show on earth”.

David Clarke
Halifax, NS; April 2024

Primers by David Clarke:

1. A FORTRAN Primer

2. A UNIX Primer

3. A DBX (debugger) Primer

4. A Primer on Tensor Calculus

5. A Primer on Magnetohydrodynamics

6. A Primer on ZEUS-3D

7. Eclipse Photography for Mortals

I also give a link to David R. Wilkins’ excellent primer Getting Started with LATEX, in
which I have added a few sections on adding figures, colour, and HTML links.
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Eclipse Photography for Mortals
David A. Clarke, Halifax NS

1 Introduction

Being a very amateur astro-photographer and an even more amateur photo post-processor,
I was easily overwhelmed by the various YouTube videos and on-line instructions by the
wizards in this game on how to take and process solar eclipse photos. Opening up a video
where the speaker talks of his top-of-the-line equipment and scores of his perfectly aligned
photos of varying exposures and f-stops can be daunting to say the least; they speak a
language of which I know not . . .

In this document, I offer how this neophyte went about taking seven (not seventy!)
images of the April, 2024 solar eclipse with an entry-level DSLR (a Canon Rebel T5 priced
in the hundreds, not thousands) with a mismatched lens (800mm, should have been 500mm)
and managed to tweak and stack them into a single image using PhotoShop (PS). To give the
reader some confidence that even this amateur was able to come up with something decent,
I offer my “before” and “after” images below in Fig. 1.

Despite an extensive search, I was unable to find anything that would do the job as well
and as simply as the inaccessibly priced PS (forget Canon’s DPP4!). The good news is, as
of this writing one can get a seven-day free trial of PS at,

https://www.adobe.com/ca/products/photoshop/free-trial-download.html

which I found to be more than enough time to process my eclipse photos.
So, without further ado, let’s get on with it!!

Figure 1: left : The single f/10, ISO 200, 0.5 s exposure, and right : the tweaked/stacked
photo of seven images with f/10, ISO 200 and exposure times 0.5, 1/4, 1/8, 1/15, 1/30,
1/60, and 1/125 s using Photoshop.
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2 My hardware

On a sturdy tripod with a level mount, I attached iOptron’s SkyTracker ProTM (C$560
including shipping, duties, taxes), set the alt to my local latitude (46◦), and used the iPhone
compass app to align the azimuth with the Earth’s axis. To the ST Pro, I attached a Neewer
low profile ball head (C$30 from Amazon.ca) and to this my Bausch & Lomb/Bushnell
800mm, f/10 telescope/lens which I’ve had for years. Over the lens’ aperture I placed a
Seymour Solar helios glass filter (C$210 including shipping, duties, and taxes) and at the
base of the lens was attached my daughter’s Canon Rebel T5 DSRL with a Cuely remote
switch (C$24 all in) so I could take pictures without actually touching the camera. Each of
these items are pictured below individually and as assembled for the eclipse on April 8.

The lens and camera together were about 2.5 pounds, just at the limit of the ST Pro’s
capacity without having to purchase the optional counterweight. However, the real limitation
with the ST Pro is alignment. At night with Polaris visible, alignment is relatively straight
forward. In broad daylight, however, one is reliant on a very coarse Alt angular dial (±0.5◦ at
best), and alignment of the Az relies on a compass. As it turns out, where we were observing
the eclipse on the property of the Atlantic Salmon Museum in Doaktown NB, the compass
app on three different iPhones swung back and forth about north by ±20◦. Evidently, there
was electromagnetic interference coming from somewhere which made alignment to the earth
axis very approximate, and my tracking suffered for it.

The other weakness was Neewer’s ball head, which had to be clamped off very tightly—
to the point where I was concerned about breaking it—so the camera and lens wouldn’t sag.
By contrast, the best value for the money was the remote switch which, with its extension
cord, allowed me to stand back to take pictures while watching totality at the same time.

Clearly there’s a much better set-up; this was the one I had. For next time, I’d get a
500 mm lens, as the 800 mm lens is too big for the Rebel T5, a “crop sensor DSLR” that is
effectively a 24 mm camera rather than 35.

(above) Canon Rebel T5 +
Bausch & Lomb 800 mm
f/10 “lens” + Cuely remote
switch; (top right) iOptron SkyTracker Pro +
alt-az mount; (above middle) Seymour Solar’s helios glass filter;
(above right) Neewer’s low-profile ball head.
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3 Required data

All photos should be taken in the camera’s raw format, as opposed to jpeg.
It’s important to practise taking pictures of the sun before eclipse day to make sure your

tracker works, to make sure you have a good focus (sunspots are a good target for that),
and to find the right exposure times. Do not rely on your camera’s automatic mode! While
automatic will find an optimum ISO/f-stop/exposure for the full sun, it fails once the moon
has covered a significant portion of it as more of the auto-focus boxes (AF points) in the field
of view are blackened out. Using the manual setting, set the ISO to 200 and the f-stop to
the lens you’ll be using (mine was f/10). Then, with your solar filter on your telescope/lens,
find the longest exposure time (e.g., 1/30 s) that doesn’t saturate your camera’s CMOS
(complementary metallic oxide sensor) or CCD (charge-coupled device). The eye is good
judge of this but, if in doubt, most cameras will show you a light histogram to tell you if
you’re far from, near, or beyond saturation. The exposure time you settle on will be your
“optimal exposure time” to use for all partial eclipse photos.

For totality, I refer you to Fred Espenak’s document How to Photograph a Total So-

lar Eclipse (https://www.mreclipse.com/SEphoto/SEphoto.html) and, in particular, his
“Solar Eclipse Exposure Guide”. For my photos with ISO 200 and f/10 (2/3 the way be-
tween his f/8 and f/11 columns), his chart guided me to using exposure times of 0.5, 1/4,
1/8, 1/15, 1/30, 1/60, and 1/125 s. In retrospect, I ought to have taken a 1/250 s as well, as
the prominences were still a bit burnt out at 1/125 s.

There will be a rapid transition between pre-totality and totality that will need to be
practised. During pre-totality with your solar filter on your lens, you’re taking photos every
two minutes, say, at ISO 200, your f-stop and your “optimal exposure time”. Just before the
diamond ring, remove the solar filter and take numerous shots in the next few seconds at
your “optimal exposure time” until true totality lights up the sky. Quickly (and this is why
you practised), cycle through your pre-determined exposure times, taking photos as quickly
in succession as you can. With practise, cycling through eight exposure times could take as
little as 40 s. If there is time, cycle back to get two sets but, whatever you do, make sure
there is at least a minute of time for you to just gaze at the event and soak it all in, listen to
the birds, check out the horizon, see if you can spot any planets. This experience can never
be replaced even by the most spectacular photos imaginable.

Immediately after cycling through your exposure times once (or twice if you have time),
reset the exposure to your “optimal exposure time”. As totality nears its end, take numerous
shots in succession (still without the filter) to capture Bailey’s beads which terminate with
a reappearance of the diamond ring. This is the moment when the solar filter should be put
back in place.

You are now back to taking photos of the partial eclipse–this time of a waning solar
crescent—where you will resume taking photos once every two minutes or so. The partial
phase typically lasts for an hour to 90 minutes on each side of totality.
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4 Post-processing

By determining an “optimal exposure time”, you should need little to no post-processing
for your waning and waxing eclipse photos, or for photos of the diamond ring and Bailey’s
beads. It will be a matter of selecting those you like the best.

Totality, on the other hand, is a different matter and the primary reason for this doc-
ument. In what follows, I take you through the steps I took using Adobe PhotoshopTM to
generate the right half of Fig. 1, a stacked image of seven photos with different exposures.
It is remarkable to me that even a quarter way through the 21st century, photography still
can’t capture the dynamic range of the human eye. As you gaze at totality, there is no part
of it that looks “burnt out”. The “rays” of the corona are clearly visible from the edge of the
moon out to a full moon diameter with no “photographic wizardry” required. On the other
hand, CMOS (CCD) technology can still do no justice to the wonder of a total eclipse. If
one exposes long enough to pick up the extent of the corona, the inner half is burnt out (left
half of Fig. 1). Conversely, an exposure time avoiding all burn-out reveals only a quarter of
what the eye can see on the photograph. As a physicist, I’ve no explanation.

I am assuming the reader has installed Adobe PhotoshopTM (and with it, Adobe BridgeTM)
under MacOSTM. For Windows users, you’ll have to alter my instructions accordingly.

1. Open Adobe Bridge (e.g., in “Finder”) and navigate to the folder with your raw images
by clicking on the appropriate icon in the left and centre-left of the tool to go “forward”,
and on the directory path in the upper left (e.g., Computer > Macintosh HD > · · · >

davidphotos) to go “back”.

Clicking on one of the thumbnails surrounds it with a blue border, indicating it’s been
selected. This selection appears in the “Preview” window to the right.
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Post-processing 5

2. Right-click the selected icon and choose “Open in
camera raw”. A new window opens with the se-
lected image and various editing tools on the right.

In the tool list, set “shadows” to +10 and “clarity”
to +75 (scroll down the tool list if “clarity” isn’t
visible). These adjustments should bring out
details of the corona without adjusting the overall

brightness and contrast. Click “Done” at the bottom right when complete, and then
repeat for all images to be stacked.

3. Still in Adobe Bridge, select all photos
to be stacked (left-click on first, shift-
left-click on last, command-left-click on
any in between that aren’t wanted),
and then from the menu bar at the
top, select “Tools > Photoshop > Load
Files into Photoshop Layers . . . ”.

This opens up a Photoshop window (image at top of next page) with the first selected
image in the main part of the window along with a host of functions in the right panel
including an iconified list of all the images to be stacked—what Photoshop refers to as
“layers”—at the bottom right. Note that for the layers to be listed, the “Layers” tab
just below “∨ Quick Actions” must be selected.

The eyeball to the left of each icon is a toggle to turn on or off the layer. Review
the separate images to be stacked by clicking the eyeball for the top layer so that the
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second image appears in the main window, then click the eyeball for the second layer
to reveal the third layer, etc.

4. Reviewing the images will likely reveal they’re not aligned! If you managed to take all
your photos so they’re perfectly aligned, bonus! Skip on to step 5. Otherwise, these
next several steps will guide you to aligning your images before trying to stack them.

a) Choose among the layers the image with the best centred moon; you’ll be aligning
the rest of the images with this. Drag this icon to the top of the list of layers.

b) Under “∨Quick Actions” is a drop-down window that defaults to “Normal”, which
shows the top layer whose eyeball is on. With all eyeballs on, change “Normal”
to “Difference” to see clearly the misalignments amongst the layers.
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c) Turn off all eyeballs except the top two to reveal differences between these layers.

d) Of the two layers with their eyeballs on, the one
selected is the one that is moved. Thus, click the
second layer and nudge it (command←↑↓→) until
its moon overlies that of the first.

To increase the “nudge resolution”, maximise the
size of the moon within the main window (com-
mand = or −). If the moon images aren’t exactly
the same size, perfect alignment could be ambigu-
ous to within a nudge or two. If so, centre them
as best you can (below image) and, if there are
other features to align (e.g., prominences), align those. Relative to the corona,
the moon does move from frame to frame but the prominences do not.
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e) With the first two layers aligned, turn off the second eyeball, turn on the third,
select the third layer, and then nudge the third layer into place. Repeat until all
layers are aligned, remembering to align prominences where available (below).

f ) Switch “Difference” back to “Normal”.

5. We must now form a single “smart object” from
all layers (in my case, seven). Select all layers
(left-click top, shift-left-click bottom) and then
from the top menu, select “Layer > Smart Ob-
jects > Convert to Smart Object”.

6. To “average” the layers and create your first
impressive image of the corona, select from
the top menu “Layer > Smart Objects > Stack

Mode > Mean”. Then, stand back and watch the magic
happen (Fig. 2 on top of the next page)!

7. Other than the bands of seemingly different exposures
along the bottom and right of Fig. 2, it looks great!
These bands are, of course, an artefact of shifting the
various layers to align their moon images with the first.
Why this doesn’t cause bands on the top and left, I
can’t say; suffice it to say I’m thankful they don’t!

So we have a choice. We can either crop the image to
the intersection of the layers thereby excluding bands
of different exposures, or . . .

8. . . . we can retain the union of the layers by salvaging the bands of apparently different
exposures exploiting Photoshop’s ability to adjust brightness and contrast within user-
defined “layers”. In this final and most extensive step, I outline how I managed to do
this to produce the right panel of Fig. 1.
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Figure 2: The result of adjusting the clarity and shadows of each layer, aligning images
of the moon and/or prominences, creating a “smart object” from the layers, and then
using Photoshop’s “mean” function. All’s well other than bands of apparently different
exposures along the bottom and right edges; top and left edges seem to be fine.

a) Select the “rectangular selection tool” from the tool bar.

b) Zoom main image to 400% (command = repeatedly) and
centre bands in the main window (below right) where five
bands (enumerated) are visible. There’s also a sixth band
one pixel wide lying between band 1 and the main image
(discovered when fiddling with brightness), but it blends
in enough with the main image to need no adjustment.

c) Pull out a rectangle (left-click and drag)
within band 1 (below left).
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Photoshop is smart enough to detect edges within the image, and the top-bottom
lines of this rectangle “snapped into place” for me. No worries if this doesn’t
happen for you; the rectangle can be adjusted manually.

d) Right-click within the rectangle just drawn out and se-
lect “Transform Selection” to light up eight “hot points”
around the rectangle that allows its size to be adjusted.
A simple left-click on a hot point then drag retains the
rectangle’s aspect ratio. To lengthen the rectangle, say,
without widening it, shift-left-click, then drag.

e) To widen the rectangle, zoom out to 25% or whatever
fills the window with the full image, and then adjust the
rectangle’s left- and right-edges. As shown lower
right, zooming out so far may reduce the rectangle’s
size to the point where all hot points are essentially
merged together. No worries, there will always be
at least one pixel in the middle of the left and right
edges that when clicked, the left-right arrows alight
telling you that a shift-left-click-drag will drag out
just the edge intended.

Again, Photoshop is very smart and will detect when your drawn-out rectangle
reaches a significant feature (e.g., the edge of the image) by flashing a magenta line
to which the edge of your rectangle will “snap”. Thus, the top-bottom edges of
the rectangle may snap to the edges of the band in the photo, while the left-right
edges of the rectangle will snap to the edges of the photo itself. Very handy.

When resizing is finished, click “Done” on the tool box just below the rectangular
selection. The blue outline and hot points disappear, and the rectangular selection
is once again highlighted by a dotted white line.

f ) Zoom in again to 400% (or where ever you were) and put
the brightest part of the selected rectangle in the centre
of the window; with a decently centred moon, this should
be the central part of the rectangle.

With the mouse inside the rectangle, right-click to pull
up the menu and this time select “New Layer. . . ”. A
dialogue box will appear (below right) asking if you
want to create a new layer. Click “OK” and a new layer
called “Layer 1” is added above the
“smart object” already listed. Note
that the white dotted line delineating
this layer will disappear at this point;
not to worry.

g) Click on the “Adjustments” tab (next
to the “Properties” tab in the upper
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right) and scroll down to and click on “Brightness/Con-
trast”. This will create another layer called “Bright-
ness/Contrast 1” linked to “Layer 1”. Select this.

h) Adjusting the brightness/contrast slide bars should only
affect the image within Layer 1. Adjust these two con-
trols until Layer 1 “disappears” into the main image.

Once satisfied with the central portion of Layer 1, scroll
to the left and right to make sure that adjustments mak-
ing the central part of Layer 1 disappear into the main
image didn’t make the extremes stand out. There will
be an optimal setting of both brightness and contrast
that makes the entire width of Layer 1 disappear into
the main image, at least to a very good approximation.

i) Once satisfied with Layer 1, repeat for Layers 2, 3, etc.,
until all bands disappear into the main image. In my case, I found that by the time
I got to Layer 5, brightness and contrast needed to be pushed to their extremes.
Thus an additional optimisation may be required whereby compromises are made
evenly over all bands to minimise their overall effect, if not eliminate them.

j ) Now repeat for the vertical bands, if any, on the right and/or left side. With all
bands now “disappeared” into the main image (go ahead, blow this page up as
much as you like and see if you can still see the bands!), we arrive at our final
product (below). Beauty.



5 Compositions

I offer here three of the compositions I assembled from my photographs using Powerpoint.
Assuming the reader has better familiarity with Microsofts’ products that Photoshop, I’ve
elected to omit the details on how these compositions were produced.

The upper left image with the first moon-bite indicates the extent of our cloud-cover that
day. All images other than the corona in the top centre are simple photographs with no
Photoshop intervention. Below is the stacked corona image with the last of the waning and
first of the waxing solar crescents superposed.
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This was sunrise from our Air B&B bedroom window near Minto NB the day of the eclipse
which we took as a damned good omen! You can see here the limitations of my photo-
manipulation skills particularly with the central image of the corona. The actual image
from Photoshop had, of course, the corona superposed over a black sky. Here, and without
changing the corona itself, I needed to change the black background to very dark blue where
the blue above the corona is darker than the blue below. I fiddled in Photoshop and Canon’s
DPP4 for hours trying to change the black centre-out gradient to a blue centre-out-plus-
below-above gradient with limited success; one can still easily see that the central image has
been inserted into the sunrise sky.

Still, the sunrise was pretty impressive!
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